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Introduction 
 
Mobile Integrated Data Acquisition Management System (MIDAS) is an 
integrated web-client-mobile application developed with J2EE technologies to 
collect and process Forest Inventory and Analysis field data.  The baseline 
system is a derivative of the field data management system developed and 
implemented in the Northern FIA region.  Each region has contributed regional 
IT skills and technologies to extend and enhance this baseline system to 
include all of the regional and national field specifications. 
 

 
 

The full suite of MIDAS tools provides crewmembers with most functions 
related to data collection.  The following features, and many others, are 
available on the PC, the Portable Data Recorder (PDR), or the MIDAS 
intranet website: 
 

 Setting up PC’s and PDR’s 

 Program updates 

 Crew access to historical information on plot to aid in data collection 

 Collection, storage, and transmission of data 

 Data edits in the field using a PDR or in the office using a PC 

 Track plot progress from the field through QAQC and into the 
database   

 



MIDAS_UsersGuide 2-26-10 ver3.docx  Page 7 of 124 

User Support 
 
Direct any questions to your local MIDAS representative: 
 
NRS  Jay Solomakos 
  jsolomakos@fs.fed.us 
  651-649-5145 
 
PNW  Chuck Veneklase 
  cveneklase@fs.fed.us 
  503-808-2045 
 
RMRS  Mark Rubey 
  mrubey@fs.fed.us 
  801-625-5647 
   
SRS  Kelly Peterson 
  kpeterson01@fs.fed.us  
  865-862-2092 
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Website Login 
 
Central to the MIDAS system is the MIDAS website that provides for a great 
deal of the functionality available in MIDAS, including but not limited to 
program installation and updates for the PC and PDR, acquiring plot history 
data, plot tracking, and transmission of completed plots to the storage 
database.  The MIDAS website can be found at the following address: 
 

http://199.131.115.1:8080/Midas/Main?action=Default 
 
The MIDAS website is an Intranet site, and can only be accessed by PC’s that 
are within the Forest Service firewall.  It is recommended that you bookmark 
this site as you will be accessing it often. 
 
If at any time while visiting the MIDAS website you 
receive a pop-up security message such as the one 
shown to the right, simply click Run to continue.  
 
 

System Access Levels 
 
For the security and protection of FIA data, all database functions are password 
protected.  As such, all of the MIDAS website functions that connect to the 
database require the user to log in with their personal username and 
password.  Each personal username will be defined with a specific access level.  
The four main levels of access to the website and database are: 

 Level 1 – Field Crew 

 Level 2 – Crew Leader 

 Level 3 – Supervisor 

 Level 4 – Administrator 
 
Level 1 users only have database read access.  Level 2, 3, and 4 users can 
update data stored in the database. The MIDAS Website user login also 
provides the administrators of the system with the means to audit usage of the 
database.  By default, all users recognized by the system are granted level 1 
access.  Only an administrator can increase a user’s access to level 2, 3 or 4. 
 

Logging In 
 
All of the functions on the MIDAS web site that connect to the database require 
the user to log in with their personal username and password, as detailed in 
the following steps: 
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1. On the MIDAS Welcome Screen, click on the Log Into System link in 

the upper right-hand corner of the screen. 

2. On the User Login screen, select a region from the Region drop-down 
box. 

 

3. Once a region has been selected, select a user name from the User 
Name drop-down box.  To avoid lengthy scrolling, the User Name drop-
down box has been coded to allow for keystroke navigation … simply 
begin typing the last name of the desired employee to go directly to that 
alphabetical section of the user name list.  Use the [Esc] or 
[Backspace] keys to reset the list if necessary. The grey box will display 
the current Midas Mobile Version and current Authorized Access Level for 
the selected User Name. 
 
Note that it may take a moment for the corresponding user name list to 
load once a region is selected, so the drop-down box may need to be 
reselected it if it has no list items. 

4. Enter your password in the Password box then either click the Login 
button or press the Enter key. New users will be provided with an initial 
Web and PDR password. Upon successful login, new users should 
change their passwords. Finish steps 5-7 and proceed directly to the 
section Changing User Passwords 

5. An automatic program update process will launch on login. MIDAS will 
check if newer components are available to update your PC. If any 
program updates are available, a New Software Found screen will be 
displayed. This will also install the MIDAS components on a new 
computer. 
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6. In most cases, the user should click on the Update button and allow the 
PC to be updated to the most current version of MIDAS. The Cancel 
option is available if the user is accessing the website via a dial-up 
connection that cannot handle the data transfer.  

7. Once the download is complete, the newest components (including 
configuration files, program files, and ActiveSync updates) should be 
installed and available on the PC … the Welcome Screen will then be 
presented, and the user’s Current System Access Level will now be 
indicated where the Login link used to be in the upper right corner of the 
screen. If the Access Level is not displayed on the Welcome screen, click 
on one of the Menu Options to refresh the screen. 

 
 

Changing User Passwords 
 
New users will be given generic passwords for Web and PDR access, and are 
highly encouraged to enter their own unique passwords when they first log on 
to the system.  These two passwords must be different. Previous users of the 
system may use this feature to change their password(s), as desired, at any 
time.  
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To change a user password: 
 

1. Once logged in on the MIDAS website, click on Utilities > Change User 
Password under Menu Options on the left side of the web page. 

 

 

2. Enter the current passwords, new passwords, and verify new passwords  
in the associated text boxes then click the Save Password button. 
 
Note that the Change User Password screen currently requires entries for 
both Web and PDR passwords. To update only the PDR password, the 
Web password entry would be your current password typed in all three 
boxes (current, new, and verify new password). Reverse the process to 
update only the Web password 

 
For previous users of the system who have forgotten their password, please 
contact a supervisor (level 3) or administrator (level 4) to have them modify 
the user profile and provide a new password within the User Manager tool. 
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Installation of MIDAS 

PC Installation 
The installation of MIDAS is designed to be a user self-install process via the 
MIDAS website: 
 

http://199.131.115.1:8080/Midas/Main?action=Default 
 
The MIDAS website is an Intranet site, and can only be accessed by PC’s that 
are within the Forest Service firewall.  It is recommended that this site be 
bookmarked as it will be accessed often. 
 
To install MIDAS, please follow the steps outlined chronologically below.  
Please note that a number of these steps require administrative permissions on 
your login account, so it is recommended that Forest Service employees use 
the Promote Me tool (http://gadgets.ds.fs.fed.us/EUTools/ad_promote.asp) to 
gain admin access prior to proceeding. 
 
If at any time during the install process you receive 
a pop-up security message such as the one shown 
to the right, simply click Run to continue.  
 

Install the Java Plug-in 
Note:  Admin access required! 

a. On the MIDAS Welcome screen, click on the Check for 
Installation/Install Java Plug-in link to begin the Java Plug-in 
installation. 
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b. A Java download window will open … click the Download Java 
Now button. 
 

 

c. A new window listing download details will appear … click the Free 
Java Download button. 
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d. When prompted, accept the default functions … click either Next, 
Yes, or OK. However, be sure to uncheck the box when you 
are prompted to install the Bing toolbar.  

 

e. Once the installation is complete, verify that the latest version of 
Java has been installed on your PC by repeating step a. Java will 
verify that you have the latest version. 

 
 
 

Log in to MIDAS 
For a detailed description of how to log in to the MIDAS web site, please 
see Logging In in the Website Login section of this document.  

 

Remove old versions of Microsoft ActiveSync 
Note:  Admin access required! 
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a. Disconnect all mobile devices from the PC … this would include 
Blackberry, Palm Pilot, IPAQ, and Allegro. 

b. From the Start menu on the Desktop, select All Programs > 
Microsoft ActiveSync 
 
Note:  If Microsoft ActiveSync is not listed under Start > All 
Programs, it may not have been previously installed on the 
system … proceed directly to the next MIDAS Install step entitled   
“Install Microsoft ActiveSync 4.5”. 

c. In the ActiveSync window, select Help > About Microsoft 
ActiveSync from the menu bar. 

d. In the About Microsoft ActiveSync window, determine the version 
of the current ActiveSync program. 
 

 

e. Click OK to close the About window, then close Microsoft 
ActiveSync. 

f. If the version of the ActiveSync program is 4.5.0 or higher, you do 
not need to uninstall your current ActiveSync or install another 
version … proceed directly to the MIDAS Install step entitled: 
“Install MIDAS PC Client”. 
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g. If the ActiveSync version is not 4.5.0 or higher, select Control 
Panel from the Start menu on the Desktop … then click on the 
Add or Remove Programs icon. 

  

h. In the Add or Remove Programs window, scroll down and select 
Microsoft ActiveSync … then click the Remove button. 
 

 

i. An Add or Remove Programs message will appear inquiring if the 
removal of ActiveSync is the desired action. Click the Yes button. 

j. When the ActiveSync window closes and the program removal is 
complete, close the Add or Remove Programs window. 

Install Microsoft ActiveSync 4.5 
Note:  Admin access required! 



MIDAS_UsersGuide 2-26-10 ver3.docx  Page 17 of 124 

a. Once logged in on the MIDAS website, click on Utilities > Install 
or Update Client under Menu Options on the left side of the web 
page. 
 

 

b. On the Install or Update Client page, click to check the Install 
Microsoft ActiveSync product … then click the Install button. 
 

 

c. After clicking the Install button, a Status message will appear … 
please be patient for a few minutes while the install program is 
downloaded onto the PC. 

d. Once the install program is fully downloaded onto the PC, it will 
automatically launch and present a Welcome screen … click the 
Next button to begin the installation.  
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e. When presented with the License Agreement, select the option to 
accept the terms in the license agreement … then click the Next 
button. 

f. A request for customer information will appear… Click the Next 
button to accept the defaults. 
 

 

g. Click the Next button to accept the default Destination Folder. 
 

 

h. Click the Install button when the setup wizard indicates it is ready 
to install the program … it may take several minutes for the 
program to install. 

i. A Setup Complete message will be displayed … click the Finish 
button. 

j. A Finished message will be displayed … click OK. 
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Install JDK 1.5 
a. Once logged in on the MIDAS website, click on Utilities > Install 

or Update Client under Menu Options on the left side of the web 
page. 
 

 

b. On the Install or Update Client page, click to check the JDK 1.5 
Installation option … then click the Install button.   
 

 
 
 

Install Ghost Script/Ghost View 
Note:  Admin access required! 
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a. Once logged in on the MIDAS website, click on Utilities > Install 
or Update Client under Menu Options on the left side of the web 
page. 

   

b. On the Install or Update Client page, click to check the Install 
Ghost Script/Ghost View option … then click the Install button. 

c. After clicking the Install button, a Status message will appear … 
please be patient for a few seconds while the install program is 
loaded onto the PC. 

 

d. Once the install program is fully loaded onto the PC, it will 
automatically launch and present a WinZip Self-Extractor message 
for the Ghostscript installation … click the Setup button. 
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e. After the install files are extracted, a Ghostscript Setup window will 
appear … click the Install button to accept all defaults and begin 
the installation. 
 

 

f. When the Ghostscript installation is complete, a File Explorer 
window will open to display the contents of the new Ghostscript 
folder … close the window. 
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g. Immediately following the completion of the Ghostscript 
installation, the GSview installation will automatically launch and 
present a WinZip Self-Extractor message … click the Setup button. 
 

 

h. After the install files are extracted, a GSView Install window will 
appear, displaying install requirements … click the Next button. 

i. Click the Next button when presented with the GSview copyright 
notice. 

j. When asked to select which files to associate with GSView, click 
the Next button to accept the defaults. 

 

k. Click Next to accept the default install directory. 
 

 

l. The default install directory does not exist … click Next to create 
the new directory. 
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m. The GSview install will present defaults for the Start Menu … click 
Finish to accept the defaults. 
 

 

n. When the GSview installation is complete, a File Explorer window 
will open to display the contents of the new Ghostgum folder … 
close the window. 
 

 

o. When the installation is finished, two different messages will 
indicate that the install was successful and is complete … click the 
Exit and OK buttons to confirm. 

 

PDR Installation 

Install Jeode JVM (Java Virtual Machine) 
Note:  Admin access required! 

a. If not already connected, establish a connection between the PDR and 
PC via ActiveSync … For instructions, please refer to the section of this 
guide entitled “Establishing an ActiveSync Connection”.  
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b. Once logged in on the MIDAS website, click on Utilities > Install or 
Update Client under Menu Options on the left side of the web page. 

   

c. On the Install or Update Client page, click to check the Install Jeode 
option … then click the Install button.   
 

 

d. After clicking the Install button, a Status message will appear … 
please be patient for a few seconds while the install program is loaded 
onto the PC. 
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e. Once the install program is fully loaded onto the PC, it will 
automatically launch and present a Welcome screen … click the Next 
button. 
 

 

f. Click the Yes button to accept the License Agreement. 

g. Click the Yes button to install to the default directory. 
 

 

h. If a MIDAS completion message appears before the Jeode install 
completes, it may send the Jeode window to the back … if this occurs, 
click the OK button in the Finished message box, then click on 
Add/Remove Programs in the task bar at the bottom of your 
desktop.  
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i. When the installation is finished, a message will appear indicating that 
the download was complete and directing attention to the PDR for 
further direction … click the OK button to confirm. 
 

 

j. On the PDR, a message may appear indicating that version is 
unsupported … click Yes to continue with the installation. 
 

 

k. Once the installation on the PDR is complete, select Start > 
Programs > Utilities > Save System. 
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Install MIDAS PDR Application 

On PC 
a. Once logged in on the MIDAS website, click on Utilities > Install 

or Update Client under Menu Options on the left side of the web 
page. 
 

 
 

b. On the Install or Update Client page, click to check the Get MIDAS 
Mobile option … then click the Install button.   
 

 

c. After clicking the Install button, a Status message will appear … 
please be patient for a few seconds while the install program is 
loaded onto the PC. 

d. A Finished message will appear … click OK. 
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On PDR 
a. Right-click on the START menu button and select Explore. 

b. Navigate to the C:\Midas folder. 

c. In the C:\Midas window, hold the CTRL key while clicking to select 
the MIDASMobile and Configurations folders … then select Copy 
from the Edit menu. 

 

d. Minimize the C:\Midas window. 

e. If not already connected, establish a connection between the PDR 
and PC via ActiveSync … if you do not know how to connect via 
ActiveSync, please refer to the section of this guide entitled 
“Establishing an ActiveSync Connection”. 

f. If the ActiveSync window is not already open, select Programs > 
Microsoft ActiveSync from the START menu to open the 
ActiveSync window. 

g. In the ActiveSync window, click the Explore button. 
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h. A Mobile Device window will open … double-click on the My 
Windows Mobile-Based Device icon. 
 

 

i. In the My Windows Mobile-Based Device window, double-click on 
the \C_Drive folder then select New Folder from the File menu 
… type Midas to name the new folder. 

j. In the C_Drive window, double-click on the new Midas folder … 
then select Paste from the Edit menu. 

k. A File Conversion message will appear … click OK. 

 

l. The MIDASMobile and Configurations folders should now appear 
in the My Windows Mobile-Based Device \C_Drive\Midas 
folder. 

m. Double-click on the MidasMobile folder. 
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n. Click once to highlight the MidasMobile-Jeode file shortcut … 
then select Copy from the Edit menu. 
 

 

o. In the Mobile Device window, click the Up button to return to the 
\C_Drive\Midas folder… then click the Up button to return to the 
\C_Drive folder… then click the Up button again to return to the 
My Windows Mobile-Based Device folder. 
 

 

p. In the My Windows Mobile-Based Device folder, double-click on 
the Windows folder … then double-click on the StartUp folder. 

q. In the Startup folder, select Paste from the Edit menu. 

r. Close the Mobile Device window. 

s. On the PDR, select Start > Programs > Utilities > Save 
System. 
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t. Press and hold the PDR’s On/Off key until the screen flashes… the 
MIDAS PDR application will automatically open. 
  
Note:  If you have not previously installed the Jeode JVM on the 
PDR, you will get an EVM error and the MIDAS program will not 
launch.  To remove the error and allow the MIDAS program to 
launch properly, please refer to the section of this guide entitled 
“Install Jeode JVM (Java Virtual Machine)” to install the Jeode JVM. 

u. Each PDR Unit now requires a Crew Login. Login is necessary upon 
initial activation of a PDR, after updating and re-booting a PDR, or 
when a PDR is used by a different crew. Your supervisor will 
provide you with initial login information. Passwords must be 
changed after initial installation is complete. Select a region from 
the Region drop-down box. Select a crew name from the Crew 
Name drop-down box. Enter the PDR Password for the selected 
crew name.  

 

 

v.  Select a PDR from the Machine Type screen. Note that this 
selection will be stored as a future default, but may be changed at 
any time using the Settings menu on the menu bar at the top of 
the MIDAS PDR screen. 
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w. The opening screen for Midas Mobile should be displayed. Region 
and Crew Name are at the top and the current program version is 
displayed at the bottom.  

 

 
 

 

Update MIDAS 
 
Routine maintenance of MIDAS will result in program updates.  It is good 
practice to update both the MIDAS PC client and the MIDAS PDR mobile 
application on occasion to ensure the most up-to-date edits are being 
performed on the data. 
 

Update the PC Client 
 

Automatic Update of the PC Client 
 
The MIDAS system has been designed to automatically check the PC Client to 
determine if it requires an update. and to automatically download and install 
the update if necessary.   
 
Upon login, a message indicating that MIDAS is checking for component 
updates will appear:  
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If new components are available, a Newer Software Found box will be 
displayed. Click on the Update button.  
 

 
 
Once the download is complete, the newest components should be installed 
and available on the PC. 
 

Manual Update of the PC Client 
 
There should be no need to manually update the PC Client, however, the 
following process is available if necessary.  Please note that the preferred and 
recommended method of updating the PC Client is via the automated process. 
 



MIDAS_UsersGuide 2-26-10 ver3.docx  Page 34 of 124 

1. Once logged in on the MIDAS website, click on Utilities > Install or 
Update Client under Menu Options on the left side of the web page. 
 

 
2. On the Install or Update Client page, click to check the Client Update 

option … then click the Install button.   
 

 

3. After clicking the Install button, a Status message will appear … please 
be patient for a few minutes while the install program is loaded onto the 
PC. 
 

4. Once the install program is fully loaded 
onto the PC, a message will appear 
indicating that the install program has 
been saved to your PC … click OK.  

5. On the PC desktop, double-click on My Computer and navigate to the 
C:\Midas\ClientUpdate folder. 
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6. In the C:\Midas\ClientUpdate folder, double-click on the ClientUpdate.exe 
file to launch the install … click the Next button on the install Welcome 
screen. 
 

7. Click the Next button to confirm the 
system information. 
 
 
 
 
 
 

 

8. Assuming the installation summary 
displays an adequate amount of available 
disk space, click the Install button to 
begin installation. 

 

 

 

 

9. When installation is finished, two 
messages will be presented indicating that 
the install was successful and is complete 
… click the Finish and OK buttons to 
confirm. 

 
 
 
 
 

Update the PDR Application 
 

Automatic Update of the PDR Application 
 
The MIDAS system has been designed to automatically check the PDR 
application to determine if it requires an update and to automatically download 
and install the update if necessary.  The automatic update is initiated when the 
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user clicks either the Send Plots to Mobile Device button or the Get Plots 
from Mobile Device button found on the MIDAS Control Panel on the PC.  The 
primary purpose of these buttons is to send plot history files to the PDR 
application and to retrieve completed plots from the PDR application.  Note 
that it is preferred that the PDR Application (MIDAS Mobile) be closed prior to 
clicking either of these buttons.  For a more detailed discussion of the functions 
and use of these buttons, please see the topics in this document entitled “Send 
Plots to the PDR” in the Preparing for Data Collection section and/or “Get 
Completed Plots from the PDR” in the Processing Completed Plots section. 
 

(Semi-Manual) Update of the PDR Application 
 
The manual update of the PDR application is not really a manual task … it is 
really just a manual initiation of an automated task.  To truly have a manual 
update would involve copying a number of files to a number of different 
directories, which can be a bit complicated.  Instead, MIDAS offers an 
automated copy of required files that is available with the click of a button.  To 
manually update the application components on the PDR, the following process 
is available: 
 

1. On the PDR, close the current MIDAS Mobile application by returning to 
the main Plot Task screen and either clicking the Exit Program button 
or selecting Exit from the File menu. 
 
Note: Return to the main Plot Task screen from within an open plot file 
by navigating to the main menu screen via the [F4] key or the Close 
button on the menu bar at the bottom of any data entry screen, then 
clicking the Exit Plot button. 

2. If not already connected, establish a connection between the PDR and PC 
via ActiveSync … if you do not know how to connect via ActiveSync, 
please refer to the section of this guide entitled “Establishing an 
ActiveSync Connection”. 
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3. Click the Update Mobile Device Components button found on the 
MIDAS Control Panel on the PC to initiate the automated copy of required 
files to the Mobile Device. 
 

 

4. An Update screen will appear … select the appropriate Region then click 
the Update button. 
 

 

5. When the update has been completed, a message will be presented 
indicating that the update was successful … click the OK button. 
 

 

6. If, for some reason, the MIDAS Mobile application running on the PDR 
was not closed prior to executing the update … it is necessary to close 
and restart the application. 

7. Click the Close button to close the Update screen. 
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Preparing for Data Collection 

 
Prior to collecting data, there are a number of items required by MIDAS that 
provide information on what and how data should be collected, as well as basic 
plot identification information.  The establishment of these items, namely 
configuration files and historical files, prior to visiting a field plot is crucial to 
the data collection process. 

Create Plot Files 
 
MIDAS requires a base plot file (referred to as a historical file) for each field 
plot that is to be measured.  The historical file is pre-populated with basic plot 
id information as well as available history data in the case of remeasure plots.  
Creating these historical files is a task available to all levels of users, and 
involves retrieving the id and history data from the field database. If data is to 
be collected using the PDR, the historical file must also be sent to the PDR 
from the PC. 
 

Retrieve Historical Data from the Database 
 

a. Once logged in on the MIDAS website, click on Field > Get Historical 
Field Data under Menu Options on the left side of the web page. 

 
 

b. On the Get Field Historical Data screen, define the Plot Selection 
criteria by selecting a region from the Region drop-down box. Some 
regions can be further defined by Sub-region. Then select a state(s) 
from the State drop-down box. There is also the option to Select All 
States. Note that when a selection is made in one box, the selections in 
the remaining boxes will be automatically updated to reflect the 
available data based on the values already selected. 



MIDAS_UsersGuide 2-26-10 ver3.docx  Page 39 of 124 

 

c. Survey Intensity can be selected for Single, Double, Triple, or All. 
Most states are at single intensity.  

d. The next selection menu is Survey type. The default selection is 
inventory year. The Change Type button can be used to list Inventory 
type by Inventory Year, Cycle/Subcycle, or Field Season Year. 
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e. Once the Inventory type has been selected, the available Phase and 
Protocol plot sets will be displayed. Choose the Phase(s) (P2, P3) 
and/or Protocol(s) (STD, STD_INV) for the plot history files that will be 
downloaded. 
 

 
 

f. The final selection on this screen is County. The counties will be 
displayed that match all of the previously selected criteria. Individual 
counties can be selected or there is a Select All option.  

   
 

g. Click on Get Selected Plots. 
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h.  All of the plot history files meeting the selection criteria will be 
displayed. Individual plot history files can be selected or there is a 
Select All option. Click on Get Plots. 

 

i. All selected plot history files will be downloaded to the default folder. To 
select an alternate folder or drive on the PC for the downloaded history 
files, check the Advanced Folder Options box and select the desired 
location.  

 
j. Click Continue to download the plot history files. A message will 

appear confirming that the plot files have been downloaded … click OK. 
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Send Plots to the PDR 
 

1. On the PDR, close the current MIDAS Mobile application by returning to 
the main Plot Task screen and either clicking the Exit Program button 
or selecting Exit from the File menu. 
 
Note: Return to the main Plot Task screen from within an open plot file 
by navigating to the main menu screen via the [F4] key or the Close 
button on the menu bar at the bottom of any data entry screen, then 
clicking the Exit Plot button. 

2. If not already connected, establish a connection between the PDR and PC 
via ActiveSync … refer to the section of this guide entitled “Establishing 
an ActiveSync Connection” for detailed instruction on how to connect via 
ActiveSync. 

3. Open the MIDAS Control Panel on the PC by clicking on the MIDAS 
Contol Panel icon on the desktop. 

4. In the MIDAS Control Panel window, click the Send Plots to Mobile 
Device button. 

 

5. After a few seconds, a Send Historical Plots to PDR window will open … 
define the Plot Selection criteria by 
selecting a region from the Region 
drop-down box, then selecting a state 
from the State drop-down box.  Note 
that when a selection is made in one 
box, the selections in the remaining 
boxes will be automatically updated to 
reflect the available data based on the 
values already selected. 

6. To further refine the selection of which 
plot files are desired, select values from 
the remaining drop-down boxes to meet 
the selection criteria.  Note that the 
Cycle, Subcycle and County drop-
down boxes will allow for the selection of All. 
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7. Once the desired selection criteria have been submitted, a list of 
available plots based on that criteria will be presented.  Click to highlight 
the desired plot or plots, using the CTRL key to select multiple plots … 
then click the Send Plots button to initiate the transfer of the selected 
plots to the PDR. 

8. A message will appear confirming that the plot file(s) have been copied 
to the PDR … click OK. 

In addition to sending over the selected plot history file(s) to the PDR, this 
process will also automatically send any new MIDAS components (including 
configuration files, program files, and ActiveSync updates) to ensure that the 
program is current and up-to-date. 
 

Print Field Plotsheet 
 
Most plots that are sent out to the field will already have a set of printed 
plotsheets. If plotsheets are missing or need to be re-printed, there is a Get 
Field Plotsheets function. The MIDAS website has a function that will print a 
blank plotsheet that contains the respective plot number, historical plot data, 
historical tree data, and the previous field crew map that has been scanned 
into the database. 
 
Note that this feature may not be available in all regions. 
 

a. Once logged in on the MIDAS website, click on Field > Get Field 
Plotsheets under Menu Options on the left side of the web page. 
 

 

b. On the Get Field Plotsheets screen, define the Plot Selection 
criteria by selecting a region from the Region drop-down box, then 
selecting a state from the State drop-down box.  Note that when a 
selection is made in one box, the selections in the remaining boxes 
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will be automatically updated to reflect the available data based on 
the values already selected. 

c. To further refine the selection of which plot files are desired, select 
values from the remaining drop-down boxes to meet the selection 
criteria.  Note that the Unit and County drop-down boxes will 
allow for the selection of All. 

d. After all Plot Selection criteria have been specified, click the Next 
button. 

 

e. Once the desired selection criteria have been submitted, a list of 
Available Plots based on that criteria will be presented.  Note that 
the plotsheet files will have a .PDF extension. 

f. Click to select the plotsheet(s) that are desired for download.  To 
select all of the listed plotsheets, click the >> button.  Otherwise, 
click to highlight the desired plotsheets, using the CTRL key to 
select multiple plots … then click the > button to move the selected 
plotsheets to the Selected Plots list.  To remove any undesired 
plotsheets from the Selected Plots list, click to highlight the 
plotsheet file then click the < button.  The << button will remove 
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all plotsheet files from the Selected Plots list. 

 

g. Click the Next button to submit the list of selected plotsheets and 
proceed to the Download Plotsheets from Server screen. 

h. Upon entering the Download Plotsheets from Server screen, the 
plotsheets are ready to be downloaded directly to a default 
directory on the PC.  The screen does offer the option to select an 
alternate location on the PC for the downloaded plotsheet files by 
clicking to select the Advanced Folder Options option and 
selecting the desired location. 

i. Click the Continue button.  The plotsheets will be downloaded 
from the server directly to either the default directory on the PC or 
to another directory on the PC as specified as an advanced folder 
option. 
 

 

j. A message will appear confirming that the plotsheet(s) have been 
downloaded … click OK. 
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k. A View Plotsheets message will appear … click the View 
Plotsheets button to open a screen for viewing and printing the 
plotsheet file. 
 

 

l. On the View Plotsheets screen, click to select the desired plotsheet 
file(s) … then click the Print button to send the plotsheet to the 
default printer for printing. 
 

 

m. Click the Close button after the plotsheet has successfully printed. 
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Data Collection on the PDR 
 

PDR Settings  
 
 While collecting data you may wish to disable the PDR touch screen.  On the 

Allegro, it can be toggled on/off by pressing TS (the Blue [       ] key and 
the Back Space[      ] key together). 
  
  
  
  
  
  
  

 

 The MIDAS Mobile program was designed to use the full height and width of 
the screen.  As such, the System Taskbar at the bottom of the screen 
should be set to Auto hide: 

1. On the PDR, select Start > Settings > Taskbar and Start Menu. 
Note that if using an Allegro, the Start menu can be opened by pressing 

the Blue [       ] key and the Start [       ] key together. 
 

 

 

 

 

 

 

 

For all instructions on the PDR, an indication to click on the screen 
can be duplicated without the use of the touch screen by using the 
[←], [→], [↑], [↓], or [TAB] keys to highlight the desired item then 
pressing the [ENTER] key.  For accessing the screen menu bar 
without the use of the touch screen, press the [ALT] key to activate 
the menus then use the [←], [→], [↑], [↓], or [TAB] keys to 
highlight the desired menu item then press the [ENTER] key. 
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2. In the Taskbar and Start Menu Properties screen, click on the General 
tab then check the Auto hide option. 

 

 

3. Click the OK button in the top right corner of the screen to apply your 
new settings. 

Starting MIDAS Mobile  
 
MIDAS Mobile is designed to launch automatically when the PDR is reset.  If 
the program has been installed but is not running on the machine, simply 
press and hold the PDR’s On/Off key until the screen flashes … MIDAS Mobile 
will automatically open. 
 

General Orientation & Navigation 
 

 In all likelihood, the touch screen of the PDR will be turned off during 
data collection in the field.  A number of standard navigation keys and 
shortcut keys are available for entering data without the use of the touch 
screen.  Refer to the Navigation/Shortcut Keys topic within the “Data 
Entry” section of this document for detailed descriptions of these keys. 

 The program will open to a Plot Task screen that provides the most basic 
actions that can be performed on a plot. The screen title bar displays the 
current Region and User Name logged on to the PDR. 
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Open Work Plot allows for the opening of an existing plot for which 
data collection is in progress.  This selection will present a listing of all 
available work plot files on the PDR … use the drop-down boxes on the 
left side of the screen to narrow down the list by State, Cycle, Subcycle, 
and/or County. 
 
Open Hist Plot allows for the opening of a base plot file that has been 
populated with downloaded history data … data collection has not yet 
begun on these files.  This selection will present a listing of all available 
history plot files on the PDR … use the drop-down boxes on the left side 
of the screen to narrow down the list by State, Cycle, Subcycle, and/or 
County. 
 
Create New Plot allows for the on-the-fly creation of a new, empty plot 
file such as would be needed in the case of a replacement plot. 
 
Restore Plot allows for the restoration of a plot that has been lost due 
to some type of critical error such as a machine crash or battery failure.  
For a more detailed discussion on this topic, refer to the “Data Restore” 
section of this guide. 
 
Delete Plot allows for the deletion of plot files from the Work folder. 
Successfully loaded plot files should be automatically removed from the 
Work folder. Files will remain in the backup folders, but will no longer 
appear in the list of Work plots to be opened/edited. 
 
Exit Program will close the MIDAS Mobile application.  
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Data Entry 
 

Data Entry Options 
 
Several options are available to customize the data entry screens.  To access 
and set these options, select Data Entry Options from the Settings menu on 
the initial Plot Task screen or press the [Ctrl] + [A] keys while on any data 
entry screen. The data entry screen structure is the same for all Regions. 
There are some regional differences in required versus optional data entry 
 

 
 

AutoJump 
When set to on, the AutoJump option will enable the cursor to 
automatically jump to the next field when data entry in a field is 
complete.  That’s to say that after the second character in a field with a 
length of 2 characters is entered, the program will automatically move 
the cursor to the next field and be ready for data entry of the next field.  
If the AutoJump option is disabled, moving to the next data entry field 
will require an additional keystroke on the part of the user, usually in the 
form of either the [] or the [ENTER] keys. 

Wrap first/last fields 
When checked, this option will enable the cursor to automatically wrap 
back from the last field to the first field of the current record, or vice 
versa.  When unchecked, returning to the last or first field would require 
the use of a navigation shortcut key, stepping through all keys in 
between, or physically clicking on the first or last field on the touch 
screen. 

Overwrite requires BS 
When entering a data entry field, any existing value is automatically 
highlighted.  When this option is checked, the existing value will not be 
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overwritten or replaced unless the [BkSp] key is first pressed to remove 
the existing value.  When this option is not checked, the existing value 
will be automatically overwritten if a number key is pressed.  Having this 
option unchecked may accommodate faster data entry; However, it also 
allows the chance for accidental overwriting of existing data. 

Allow program to null data 
This option allows the plot edit program to delete data and remove data 
fields that no longer apply to data entry screens. For example, a sawlog 
assigned a tree class of 2 is given a tree grade. Upon further inspection, 
the tree is changed to a tree class 3. The tree grade data and data field 
are no longer necessary. A plot edit will remove this data, rather than 
requiring the user to manually remove the tree grade data entry. 

Grid - No Screens / All screens / Multi record screens / 
Trees only 

The grid “screens” option allows the user to set which screens will appear 
in grid format.  This setting will be applied when a plot file is opened, but 
will be disabled if the [Ctrl] + [D] toggle is used while the plot file is 
open, and the user will then be required to use [Ctrl] + [D] to toggle 
between grid and full record format while the plot remains open.  Closing 
and reopening the plot or opening a new plot will once again engage the 
grid “screens” option setting.  Only 1 of the 4 options may be selected at 
one time … selecting one will deselect the remaining 3. 

Grid - Autosave Records 
Autosave should usually be set to on to prevent data loss. However, 
Autosave can slow the ability to enter and scroll through tree data fields 
in the grid format. Unchecking this option can speed up the tree data 
entry in grid format but cruiser must be wary of potential for data loss.  

Grid - Abbreviate prompts 
When set to on, the field prompts on the grid display will be reduced to 
only 2 characters instead of the standard 5 characters.  If there is any 
question as to what the active field is, the full field name is displayed in a 
black box in the upper right corner of the Tree frame. 

Grid - Use fixed vertical scrolling 
When checked, the fixed vertical scrolling option will attempt to keep the 
active grid row centered in the middle of the grid.  
 

Grid - Advance Record on Wrap 
This option allows a new record to be added automatically when the 
cruiser scrolls past the last data entry field of the last record.  
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Open a Plot File 
 

 To enter data for a plot, the history file for the desired plot must have 
been downloaded to the PDR.  See the previous sections of this 
document entitled “Retrieve Historical Data from the Database” and 
“Send Plots to the PDR” for detailed instruction on downloading history 
files. 

 To open a plot file for data entry, click either the Open Hist Plot or 
Open Work Plot button on the main plot task screen.  For a more 
detailed description of these buttons and how to select and open a plot, 
see the previous section entitled “General Orientation & Navigation”. 

Main Menu 
 

 When a plot is opened, a “home” screen will appear.  This home screen 
or main menu will allow the user to go to a specific part of the plot file if 
desired.  Letter keys, contained in parentheses () preceding the menu 
names, are available as shortcuts when entering data without the use of 
the touch screen. 
 

 

 Unlike the other national data entry screens, the Owner data entry 
screen is available only via the main menu.  Since Owner data is 
collected at the court house rather than in the field, it is neither 
necessary nor desirable for the Owner screen to appear when scrolling 
through the data entry screens using the next/previous menu feature 
while collecting data in the field. 

 At the bottom of the main menu, the current active subplot is displayed.  
For data collection screens that are collected on each subplot, clicking or 
selecting the data menu from the main menu will open the corresponding 
collection screen for the active subplot.  To change the active subplot, 
click or select the Set Active button on the main menu.  
 
Note that when using the next/previous menu feature to scroll through 
the data collection screens rather than selecting them from the main 
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menu, MIDAS will scroll through all screens for a particular subplot. 
Some PDR’s will allow this feature to scroll to the next subplot. 

 Once all data has been entered for a plot, click the Edit Plot button to 
run all validation edits on all data entry screens for the current plot.  A 
complete detailed explanation of the Edit Plot feature can be found in a 
later section of this document entitled “Edit Plot Data”. 

 The Exit Plot button will close the current plot file and return the user to 
the main plot task screen. 

Data Entry Screens 
 

 The data entry screens may be toggled between 2 different formats 
depending on user preference … full record format or grid format.  For 
the full record format, only one record is displayed at a time with as 
many fields for that record displayed as possible. For the grid format, all 
records are displayed with one record per row. To toggle from one to the 
other, press the [CTRL] + [D] keys. 
 

      
Full  Record                                                 Grid 
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 Despite the small size of the PDR display, the MIDAS data entry screens 
have been designed to present a vast amount of information in as little 
area as possible so that the user has the information they require in front 
of them at all times.   
 

 
Sample Tree Screen from MIDAS Mobile  (Full Record View)  
 

 
Sample Tree Screen from MIDAS Mobile  (Grid View)  

 On occasion, changing the value that 
was previously entered in a field may 
result in another field no longer being 
required to be collected.  In this situation 
the field that should not be collected but 
which still contains a value will be 
highlighted with a grey background to 
alert the user to return to that field and 
delete the contents.  For example, a 
change in Plot Status from a value of 2 
to a value of 1 would result in the 
Subplots Examined field no longer 
requiring a value, as seen at right.  
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Entering Plot Coordinate Data 
 
The MIDAS Mobile application provides for two ways to enter coordinate data … 
either manually via the PDR keyboard or by electronic import. 
 

Manual Entry of Coordinate Data 
Although the importing of electronic coordinate data is the preferred method 
for entering plot coordinates, it is also possible to simply enter the data 
manually via the PDR keyboard. 

A word of caution on manually entering the Longitude Degree value … if the 
coordinate is a negative coordinate, it must be entered as such.  On the 
Allegro, a negative sign is entered by pressing the Blue [       ] key and the 
Decimal [     ] key simultaneously.  Alternatively, the user may also access 
the help menu while in the longitude degree field and select the negative 
coordinate value from the list of available coordinates. 
 

 

Importing Electronic Coordinate Data 
In order to eliminate data transcription errors, the MIDAS program has the 
ability to read GPS coordinates from an electronic file and automatically 
update the coordinate fields in the plot file with those values.  At this time, 
the coordinate import feature is available only for Allegro PDR’s running the 
LandmarkCE software from Juniper Systems.  The following steps are 
required to import the coordinate data: 

1. Activate the Landmark software on the Allegro. Turn on the EMTAC 
GPS Unit that is blue-tooth linked to that Allegro. Wait for EMTAC to 
locate enough satellites to pinpoint your position within specified 
tolerances. 

2. Under the Waypoint (Wpt) selection, click on the Mark button. Name 
the waypoint and click on the Export button. The Export button on 
the LandMark CE Mark Point screen will start the collection of GPS 
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data. When 180 readings are collected within specified parameters, 
the GPS data will be automatically written to a temporary electronic 
file. 

3. In the MIDAS Mobile program on the Allegro PDR, navigate to the GPS 
data entry screen within the plot file … press the [CTRL] + [K] keys 
to automatically import the coordinate values, PDOP, and EHE. 

Note that the coordinate values must be imported into MIDAS within 15 
minutes of the time that they were collected and saved using the 
LandmarkCE software to ensure that the proper coordinates are associated 
with the corresponding plot data. 

Adding a New Tree Record (or Condition, or Boundary, or …) 
 
For data screens that contain multiple records, such as the Tree screen, it is 
not uncommon to require the addition of a new record: 
 

 When viewing tree records on the Tree screen in full record mode, 
navigate to the final existing tree record then click the NxTr button on 
the bottom menu bar to add a new tree record.  If the touch screen is 
not active, press the [TAB ] key. 

 
 To add a new tree record when viewing in grid mode, navigate to the 

final existing tree record then press the [TAB ] key.  
 

 Navigate to the tree field (TR#) for the new record. Press the [Ctrl] + 
[C] keys to auto-populate the field with the next tree # available for that 
subplot. 

 
This same logic also applies to other multi-record screens … NxCo will add a 
new condition, NxBn will add a new boundary, and so on. 
 

Data Tools, Functions, and Function Keys 
 
The data collection screens have a number of navigation aids, data tools and 
functions that are accessible via the menu bar at the bottom of the data entry 
screen or via the function keys. While the menu bar is discussed in detail in a 
later section of this document entitled “Menu Bar”, the following is a 
description of the functionality that is accessible via the function keys: 
 

 F1 Function Key: Item Help 
 Displays data help screens, including both valid value information and 

field guide descriptions.   
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 When the [F1] key is first pressed, it displays a list of valid values, if 
applicable, for the given data field.  For measurement type fields that do 
not have a valid list, an indication of “Legal List Not Available” will be 
displayed.   

 To view the full field guide description of the given data field, press the 
[F1] key again (or click the Toggle Help button) while the valid list help 
screen is displayed. 

 To select a value from the list of valid values, use the arrow keys to 
highlight the selection then press the [Enter] key or click the Accept 
button. 

 To close the help screen without making a selection, press the [Esc] key 
or click the Close button. 

 The help screens may be accessed via the Func button in the menu bar 
at the bottom of the data collection screen … click Func then click Item 
Help (or press the [A] key). 

F2 Function Key: Next Menu 
 Press the [F2] key to navigate to the next data menu screen, i.e. move 

from the Tree screen to the Seedling screen.   

 The Next Menu functionality is also available via the NxMn button in the 
menu bar at the bottom of the data collection screen.  

F3 Function Key: Previous Menu 
 Press the [F3] key to navigate to the previous data menu screen, i.e. 

move from the Seedling screen to the Tree screen.   

 The Previous Menu functionality is also available via the PrMn button in 
the menu bar at the bottom of the data collection screen.  

F4 Function Key: Return to Main Menu 
 Press the [F4] key to navigate to the main menu.  

 Returning to the main menu is also possible via the Close button in the 
menu bar at the bottom of the data collection screen.  

F5 Function Key: Data Tools & Functions 
 Press the [F5] key to access a menu for available data tools and 

functions.   

 The menu of available data tools and functions is also available via the 
Func button in the menu bar at the bottom of the data collection screen.  

 The Func button and [F5] key are available on all data collection screens 
with the exception of Owner. 
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 The menu of data tools and functions is dynamic, meaning that it is 
different from screen to screen.  The first three menu items are static 
and will always appear.  The other items, however, will only appear if 
they are applicable for the currently active data screen. This is a sample 
[F5] key menu: 
 

 

 The following is a brief description of available tools and functions: 

Static – These are fixed items under the [F5] key. 
 

Item Help 

Displays data help screens, including valid value lists and field guide 
descriptions.  Item Help is also accessible via the [F1] Function key. 

Calculate Slope 

Calculation tool for determining Horizontal Distance and Slope Correction 
based on user inputs of % Slope and Slope Distance. 

Locate Subplot 

Calculation tool to aid crews in navigating from one subplot to another 
without going back to subplot #1 by determining Distance and Azimuth 
between plot centers based on user inputs of starting subplot number 
and destination subplot number. 

Dynamic – These functions are available via the [F5] key based 
on the active data collection screen and/or regional preferences. 
 

Traverse 

This item helps the cruiser traverse around obstacles and stay on course 
to the plot. 

List Hot Keys 

 Displays a list of all hot keys currently available in the program. 
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View All Notes 

Old Notes presents a list of any notes that were provided by previous 
field crews, as downloaded as part of the plot’s history data. New Notes 
lists all the notes added to the current plot data. 

Select Subplot 

This function allows the user to switch to another subplot while working 
in a subplot specific data collection screen, such as Tree or Boundary.  
The Select Subplot menu item would not appear on a screen such as GPS 
since GPS data is entered for the plot as a whole rather than for a 
specific subplot.  Select Subplot is also accessible via the [Ctrl] + [I] key 
combination … [Ctrl] + [O] and [Ctrl] + [U] will allow navigation to the 
previous and next subplots respectively. 

Delete Record 

For multi-record data collection screens, such as Tree, this function 
allows the user to delete the current record.  This function will not, 
however, allow the deletion of a record which contains historical data. 

Record Navigation 

For multi-record data collection screens, such as Tree, this function 
allows the user to move to a specific record within the data screen.  A 
submenu allows for the selection of First Record, Last Record or Go to 
Record #, which prompts the user to enter a record number. 

Delete Subplot Trees 

Available only for QAQC plots, this function allows for the deletion of all 
tree records on a specific subplot that were not measured for quality 
control. Subplot status must also be recorded as 4 to successfully delete 
subplot trees. 
 

Delete Subplot Seedlings 

Available only for QAQC plots, this function allows for the deletion of 
seedlings on a subplot. 

Enter Note For All Subplot Trees 

Allows user to write one note that can be applied to all of the trees on a 
subplot.  
 

Autofill Condition 

Allows user to apply one condition number to all of the trees on a 
subplot. 
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Boundary Diagrams 

Will display a two-dimensional view of current boundaries mapped on the 
current subplot.  
 

Radial Age Display 

Displays all trees selected for radial growth and/or age to assist with 
meeting the minimum requirements for radial growth and aged trees per 
diameter class and species.  Also verifies that those selected fall within 
the range of suitable radial/age trees. 

 
 

Condition Definitions 

Provides a snapshot of all recorded condition information for a given plot, 
both condition-delineation and ancillary information is provided. 

 
 

Create (Region) Site Trees 

 Auto-populate associated site tree fields from the currently selected tree. 
 
 

Veg. Species View (Region) 

 A listing of species names for the current region. 
 
 

Age Extrapolation Calculator 

Extrapolates an estimated number of rings, (i.e. Age), for the tree based 
on the number of rings in the core sample and the tree diameter. 

 
 
  

Menu Bar 
 
The data collection screens have a number of navigation aids, data tools and 
functions that are accessible via the menu bar at the bottom of the data entry 
screen or via the function keys. While the function keys have been discussed in 
a previous section of this document entitled “Data Tools, Functions, and 
Function Keys”, the following is a description of the functionality that is 
accessible via the menu bar at the bottom of the data entry screen: 
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 Next Menu 
 Navigates to the next data menu or collection screen, in order as 

presented on the main menu screen.  If on the Tree screen, for instance, 
clicking the NxMn button will navigate to the Seedling screen.   

 For data menus that are collected on each subplot, Next Menu will 
proceed through all screens for one subplot then loop back and proceed 
through with the data menus for the next subplot.  

 Regional data menus will be viewed via the Next Menu functionality. 

 The Ownership menu will not be viewed via the Next Menu functionality 
… it must be selected from the main menu screen. 

 If the touch screen is not active, the Next Menu functionality is also 
available via the [F2] key. 

 Previous Menu 
 Performs in the same manner as Next Menu, going to the previous menu 

rather than the next menu. 

 If the touch screen is not active, the Previous Menu functionality is also 
available via the [F3] key. 

 Next Submenu 
 Navigates to the next submenu, such as next tree, next condition, or 

next subplot. 

 Available only on data collection screens that may have multiple records, 
such as tree or condition. 

 If viewing records as a full record, the next submenu will refer to the 
next record of the active menu screen … so when on the Tree screen the 
NxTr button will allow the user to move to the next tree for the current 
subplot.  Note that the button label will change based on the active menu 
screen … NxBn if on the Boundary screen, NxCo if on the Condition 
screen, and so on.  When in grid view, the next submenu will always 
refer to subplot … so when viewing a grid listing of tree records for one 
subplot, the user can use the NxSu button to present the list of tree 
records for the next subplot. 
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 When viewing tree records on the Tree screen in full record mode, 
clicking the NxTr button while the final tree record is active will add a 
new tree record. To add a new tree record when viewing in grid mode, 
navigate to the final existing tree record and press the [TAB ] key. This 
same logic also applies to other multi-record screens … NxCo will add a 
new condition, NxBn will add a new boundary, and so on. 

 If the touch screen is not active, the Next Submenu functionality is also 
available via the [TAB ] key. 

 Previous Submenu 
 Performs in the same manner as Next Submenu, going to the previous 

submenu rather than next. 

 If the touch screen is not active, the Previous Submenu functionality is 
also available via the [ TAB] key. 

 Note 
 Enter a field text note for the active screen. 

 If the touch screen is not active, the Note functionality is also available 
by pressing the [CTRL] + [N] keys. 

 Close 
 Click the Close button to close the current data collection screen and 

navigate to the main menu.  

 When the touch screen is not active, returning to the main menu is also 
possible via the [F4] key.   

 Functions 
 Press the Func button to access a menu for available data tools and 

functions.   

 If the touch screen is not active, the menu of available data tools and 
functions is also available via the [F5] key. 
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 The Func button and [F5] key are available on all data collection screens 
with the exception of Owner. 

 For a complete description of all data tools and functions available 
through the Func button, please refer to the description provided under 
the [F5] key heading in the previous section of this document entitled 
“Data Tools, Functions, and Function Keys”. 

 

Navigation/Shortcut Keys 
 
During data entry, there are several navigation and shortcut keys that will 
allow you to move easily between fields on a screen, between records on a 
multiple-record screen (i.e. different trees on the Tree screen) and between 
different data entry screens altogether.  These keys are especially useful when 
collecting data in the field, as the touch screen will likely be turned off.  
Standard navigation keys include the Arrow keys, Enter, Tab, and Back Space: 
 

 Arrow keys ([], [], [], []) will navigate between data fields. 

 The [Enter] key will validate the data entered and navigate to the next 
data field. 

 The [Tab] key, right or left, will navigate between records, i.e.  Tree #1 
to Tree #2. 

 The [BkSp] key will delete entered text for the active data field. 

In addition to standard navigation keys, many shortcut keys are available to 
immediately access menu item options without having to move through the 
menu bar system.  These include use of the function keys (F1-F5) and ‘Ctrl + 
key’ or ‘Alt + key’ to move between records and between different data entry 
screens altogether.  For shortcut keys that are paired with the Ctrl or Alt key, 
the user is free to use either the Ctrl key or the Alt key to activate the 
shortcut key … this is for ease of use depending on where the shortcut key is in 
relation to the Ctrl and Alt keys on the PDR keyboard. In most cases, the 
shortcut keys may be either pressed simultaneously with the Ctrl or Alt key or 
pressed immediately after the Ctrl or Alt key is pressed and released. To 
access a different data screen or option, you may use the shortcut keys 
directly, or select the desired screen/option from the Menu Bar.  The following 
is a list of the shortcut and navigation keys that are available at this time: 
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Key Action 

Menu Navigation 
F1 Help 
F2 Next menu 
F3 Previous menu 
F4 Main menu 
F5 Functions 

Subplot Navigation 
Ctrl + I  or  Alt + I Select subplot * 

Ctrl + O  or  Alt + O Previous subplot 
Ctrl + U  or  Alt + U Next subplot 
Ctrl + 1  or  Alt + 1 Switch to subplot 1 * 
Ctrl + 2  or  Alt + 2 Switch to subplot 2 * 
Ctrl + 3  or  Alt + 3 Switch to subplot 3 * 
Ctrl + 4  or  Alt + 4 Switch to subplot 4 * 

General Navigation 
Tab Left Previous record ** 

Tab Right Next record ** 
Ctrl + B  or  Alt + B Jump to middle of data fields on current screen 
Ctrl + F  or  Alt + F First record 
Ctrl + L  or  Alt + L Last record 
Ctrl + G  or  Alt + G Go to record 
Ctrl + H  or  Alt + H Home 

Data Entry 
BkSp Delete entered text 
Esc Exit edit mode and restore previously entered value 

Ctrl + A  or  Alt + A Data entry options screen 
Ctrl + C  or  Alt + C Next tree number 
Ctrl + D  or  Alt + D Toggle between single record and grid data entry 
Ctrl + S  or  Alt + S Save plot 
Ctrl + K  or  Alt + K Read in GPS File Exchange Folder coordinates 
Ctrl + M  or  Alt + M Get slope correction * 
Ctrl + P  or  Alt + P Diameter root collar 
Ctrl + N  or  Alt + N Note 
Ctrl + W  or  Alt + W Edit current record 
Ctrl + X  or  Alt + X Edit current menu 
Ctrl + Q  or  Alt + Q Sort trees by ascending azimuths, trees then saplings 

Grid Navigation (not available in single record view) 
Ctrl +  Next record / new record 

Ctrl +  Toggle between auto-jump right and auto-jump down 
PgUp Scroll up through records a page at a time 
PgDn Scroll down through records a page at a time 

Blue +  Scroll right, ignoring conditional shading ** 

Blue +  Scroll left, ignoring conditional shading ** 

 
* When entering data on the Allegro, the Ctrl key will not work for a select few hot keys if 
pressed simultaneously with the number/letter key … that is to say that Ctrl key will only work if 
pressed and released before pressing the hot key rather than pressing both the Ctrl key and the 
hot key at the same time. 
 
** Only available on the Allegro. 
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Edit Plot/Active Subplot Data 
 
Throughout the data entry process, a number of background edit checks will be 
occurring while data is entered, including valid value checks and range checks.  
There are, however, a number of more complicated edit checks that cannot be 
run until all plot data has been entered.  These types of edit checks involve 
multiple fields, often from multiple data screens, and their relationship to each 
other.  Due to the nature of these edits, the program cannot possibly know 
when to run them automatically so they must be manually initiated.   
 
Once all data entry has been completed on a plot/subplot, run the full suite of 
edits on the plot/subplot: 
 

1. Return to the plot’s main menu screen by either pressing the [F4] key or 
by clicking the Close button on the menu bar at the bottom of a data 
entry screen.  

2. On the main menu screen, press the [E] key or click the Edit Plot 
button. Then select Edit Plot or Edit Active Subplot to run all validation 
edits on all data entry screens for the current plot/subplot. 
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3. A Plot Editor screen will appear listing all errors (notated with [E]) and 
warnings (notated with [W]) for the plot 

 

 

4. Click on any error or warning within the Plot Editor window to go directly 
to the appropriate data entry screen for correction of the error or 
warning.  If the touch screen is disabled, use the [] and [] keys to 
select the desired error and then press the [ENTER] key. 
 
Note that all errors (notated with [E]) must be corrected, while warnings 
(notated with [W]) should be reviewed, correcting only if deemed 
necessary. 

5. Once the error is corrected, use the [F4] key or the Close button on the 
bottom menu bar to return to the error list. 

6. If there are more errors remaining on the list, it is highly suggested to 
click the Refresh Edit button. It is not uncommon for the correction of 
one error to actually correct several other errors, so it really is best to 
start with a fresh list. 

7. Repeat steps 4 through 6 until all must fix (notated with [E]) errors have 
been corrected.  It is the decision of the user as to whether or not any 
warnings (notated with [W]) should be fixed. 

 
Note that if the list contains any errors (notated with [E]), the plot may be 
transmitted to the PC but it will not be able to be uploaded to the database.  
The transmission of plots containing errors should be reserved for unusual 
circumstances, such as a problem in the MIDAS edit checks that has not yet 
been resolved.  The general rule of thumb is that all errors should be resolved 
prior to transmitting a plot to the PC.   
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Allegro Reboot and Data Restore 
 
In the event of some type of critical error, such as a machine crash or battery 
failure, the Allegro needs to be rebooted and plot data may need to be 
restored.   
 

1. If the Allegro experiences a malfunction or the Midas program terminates 
due to a critical error, the Allegro should first be rebooted. There are 3 
methods of rebooting the PDR that can be employed. If the first reboot 
method doesn’t fix the error, then try the next reboot method. 

a. Press and hold the ON/OFF key until the PDR shuts down and 
starts a warm reboot. 

b. Press and hold the Shift key. While holding the Shift key, press 
and hold the ON/OFF key. When the machine shuts down and 
starts to reboot, release the ON/OFF key first and then the Shift 
key. This will bring up a boot menu. Choose the cold boot option 
since the warm option was already attempted in step a.  NOTE:  
This level of reboot is also useful to resolve any active sync 
connection issues. 

c. If the machine does not respond to the previous reboot 
attempts, there is another reboot method. Turn the machine off 
and remove the battery from the back of the machine. Wait for 
15 minutes and then replace the battery. Turn the machine back 
on and allow it to reboot.  

2. Once the PDR has successfully rebooted, open the work file that was 
being updated when the crash occurred. If the file will open and there is 
little or no data loss, you can continue to enter data.  However, if the 
work file has experienced data loss, or is corrupted and will not open, the 
user must initiate the Restore Plot function on the Plot Task screen. 

 

3. The restore screen will display a list of plots available to be restored.  
Saved plots can be searched by State/Cycle/Subcycle/County, Backup 
folder, and Study Type. There are 3 sources of backup files on the 
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Allegro. The Perm Backup folder contains only the latest saved versions 
of plot files but it will automatically restore all of the study type files 
associated with that plot. The Backup and Ext Backup folders contain 
versioned backups. Versioned backup folders contain multiple file 
backups that are differentiated with an added extension of .1, .2, .3, and 
so on. MIDAS maintains up to 30 of the most recent versions of a single 
plot. The file with the highest numbered extension will be the most 
recently saved version.  

 

Backup 

a. This folder is where versioned backups of P2/P3 work files and other 
plot study types are stored when no external memory card is plugged 
into the back of the PDR. Plot files and associated study type files 
must be restored individually using this backup source. Choose the 
Backup option in the restore location box. Choose the file study type 
to be restored. 

  

b. Click to highlight the desired version of the plot file for recovery and 
then click the Restore button. In all likelihood, the file with the highest 
numbered extension (the most recently saved version), or the very 
previous one, will be the one that should be chosen. Earlier backup 
versions are available if the most recent versions are corrupted. Click 
on Restore and then click OK after the plot file is restored.  Note that 
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once a specific version is restored, the plot can be opened from the 
Work folder, the data verified, and the plot restored again from a 
different version if needed. 

  

 

Perm Backup 

The plot files in this folder are not versioned and can only be restored to 
the latest backup. Perm backup will automatically restore the most 
recently saved version of the P2/P3 plot file and all study types 
associated with the plot (DWM, soils, etc.).  Note that the study type 
selection box is shaded out. This backup method is useful when a plot file 
was deleted accidentally and there is no data loss or file corruption 
associated with the plot to be restored. Click on Restore and then click 
OK after the files are restored.  

  

 

 

Ext Backup 

c. This is the versioned backup data stored on the external memory 
card. When the external memory card is plugged in and functional, all 
versioned backup data will be stored on this card. Individual plot files 
and associated study type files must be restored using this backup 
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source. Other than where the data is stored, restoring from this 
backup location is identical to restoring from the Backup location 
described above.  Choose the Ext Backup option in the restore 
location box. Choose the file study type to be restored. 

 

  

a. Click to highlight the desired version of the plot file for recovery 
and then click the Restore button. Note that, in all likelihood, 
the file with the highest numbered extension (the most recently 
saved version) will be the one that should be chosen. Earlier 
backup versions are available if the most recent version is 
corrupted. Click OK after the plot is restored.   

  

 

4. Click the Exit button to close the Restore screen. 

5. On the main Plot Task screen, click the Open Work Plot, then select 
and open the restored plot file. 
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Processing Completed Plots 
 
Once a plot file is completed on the PDR, it will need to undergo a multi-step 
process prior to being finalized and submitted to the database.  This section 
will provide a detailed outline and explanation of those steps. 
 

Get Completed Plots from the PDR 
 
When plot data is completed, it is necessary to transfer the plot file from the 
PDR to the PC so that the file may be transmitted/uploaded to the database. 
 

1. On the PDR, close the current MIDAS Mobile application by returning to 
the main Plot Task screen and either clicking the Exit Program button 
or selecting Exit from the File menu. 
 
Note: Return to the main Plot Task screen from within an open plot file 
by navigating to the main menu screen via the [F4] key or the Close 
button on the menu bar at the bottom of any data entry screen, then 
clicking the Exit Plot button. 

2. If not already connected, establish a connection between the PDR and PC 
via ActiveSync … refer to Appendix A of this guide entitled “Establishing 
an ActiveSync Connection” for detailed instruction on how to connect via 
ActiveSync. 

3. Make sure that the PDR is plugged into an external power source (rather 
than running on batteries) to prevent it from powering off during file 
transfer. 

4. Open the MIDAS Control Panel on the PC by clicking on the MIDAS 
Contol Panel icon on the desktop. 

5. In the MIDAS Control Panel window, click the Get Plots from Mobile 
Device button. 

 

6. After a few seconds, a Get Plots from PDR window will open … define the 
Plot Selection criteria by selecting a region from the Region drop-down 
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box, then selecting a state from the State drop-down box.  Note that 
when a selection is made in one box, the selections in the remaining 
boxes will be automatically updated to reflect the available data based on 
the values already selected.  

7. To further refine the selection of 
which plot files are desired, 
select values from the remaining 
drop-down boxes to meet the 
selection criteria.  Note that the 
Cycle, Subcycle, County and 
QAQC drop-down boxes will 
allow for the selection of All. 

8. Once the desired selection 
criteria have been selected, a list 
of available plots based on that 
criteria will be presented.  Click 
to highlight the desired plot or plots, using the [CTRL] key to select 
multiple plots … then click the Get Plots button to initiate the transfer of 
the selected plots from the PDR to the PC. 

9. In the Get Plots from PDR window, processing messages will be displayed 
in the lower left corner to inform the user of progress … messages will 
include (but are not limited to) process descriptions such as checking for 
PDR updates, retrieving plot files, and validating plot files. 

10. If a plot file contains errors, the validation will fail and a message will 
appear asking if the file should be copied to the PC … click Yes or No to 
continue. 
 

 
 
Note that while files with errors may be copied from the PDR to the PC, 
they may not be uploaded to the database. 

11. A message will appear confirming the number of plot file(s) that have 
been copied successfully to the PDR … click OK. 

 
In addition to retrieving selected plots from the PDR, this process will also 
automatically send any new MIDAS components (including configuration files, 
program files, and ActiveSync updates) to the PDR to ensure that the program 
is current and up-to-date. 
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Edit Completed Plots  
 
Once the completed plot file(s) have been retrieved from the PDR they can be 
edited on the PC or on the MIDAS website.  While both edits run the same 
edits that are run on the PDR in the field, the website edit will also include 
additional database edits.  The PC based edit allows Supervisors and Crew 
Leaders to edit the crew data offline before it is loaded into the database. 
 
The following steps will outline the editing of a single plot file.  For greater 
efficiency, the edit process has been designed to edit multiple plots together in 
the same edit session.  Tips on the editing of multiple plots will follow the 
single plot outline. 
 

1. Launch the desired plot editor: 
 
PC Based Edits (Offline) 

a. Click on the MIDAS Contol Panel icon on the PC desktop to open 
the MIDAS Control Panel … then click the Edit Field Plots - 
Offline button to launch the plot editor screen. 

 

Website Edits 

a. Once logged in on the MIDAS website, click on Edit > Plot Editor 
– Field under Menu Options on the left side of the web page. 
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b. On the Plot Editor Field screen, specify a Region, Study Type, and 
Measurement Type … then click the Edit Plots button. 

c. A status message will appear at the bottom of the Plot Editor Field 
screen indicating that MIDAS is accessing historical data from the 
database… When finished, the plot editor screen will be launched. 

 

2. In the Plot screen, select a region from the Region drop-down box on 
the left side of the screen … a list of all available plots for that region will 
be displayed in the Plot List. 

3. To further refine the list of available plot files, select values as 
appropriate from the remaining drop-down boxes along the left side of 
the screen, including state, cycle, study type, etc.  Note that when a 
selection is made in one box, the selections in the remaining boxes will 
be automatically updated to reflect the available data based on the 
values already selected. 

4. Click on the plot name in the Plot List to select the desired plot … the plot 
file will load and the name of the selected plot will appear in the Selected 
Plot text box. 
 

 

5. Clicking on any of the Data Menus or Regional buttons will present a data 
entry screen similar to the PDR program. 

6. To run extensive edits on the plot data, click the Edit Current Plot 
button in the Edit Plots box. Then click on Edit Plot or Edit Active Subplot 
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(designated in the Select Subplot box). A Plot Editor window will appear 
listing all errors (notated with [E]) and warnings (notated with [W]) for 
the plot. 

  

7. Click on any error or warning within the Plot Editor window to be taken 
directly to the appropriate data entry screen for correction of the error or 
warning.  Note that all errors (notated with [E]) must be corrected, while 
warnings (notated with [W]) should be reviewed, correcting only if 
deemed necessary. 

8. Once an error or warning is corrected, click the Refresh Edit button to 
re-run the edits. Continue until correctable errors are removed and all 
warnings have been reviewed and verified or corrected. 
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9. Once all data corrections have been made … click the Save Data button 
in the Save Plot Data box.  If, for some reason, the data corrections 
should not be saved … click the Discard Changes button in the Save 
Plot Data box. 

10. If finished editing plots, close the Plot screen. 
 
For efficiency, this process has been designed to allow for editing multiple plots 
together in the same session.  The following actions are available to that end: 
 

 Click on the Previous Plot or Next Plot buttons in the Selected Plot box 
to scroll through the list of plots in the Plot List. 

 In the Edit Plots box, clicking the Edit Current Plot button will run the 
validation checks on the active plot while clicking the Edit All Plots 
button will start at the first plot on the list in the Plot List and continue 
down the list editing plots until a plot is located with an error or warning 
message.  Clicking the Continue Editing button will continue down the 
list editing until another plot is located with an error or warning message. 

 
 

Print Completed Plots 
 
A utility for printing a hardcopy of plots is available via the MIDAS Control 
Panel on the PC.  This utility provides for the creation of a hardcopy backup of 
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completed plots, as well as the ability to print and review plot data to examine 
for accuracy. 
 

1. Click on the MIDAS Contol Panel icon on the PC desktop to open the 
MIDAS Control Panel … then click the Print Field Plots button. 

 

2. In the Print Plots screen, select a new folder source if necessary then use 
the drop-downs in the Selection Criteria box to narrow down the list of 
plots in the Select Plots To Print list. 
 

 
 
Note that if there is a need to print plot data to examine it for accuracy 
prior to the plot being transferred to the PC, select the Mobile Device 
(PDR) option in the Select Folder Source box. 

3. Click to highlight the desired plot or plots for printing, using the [CTRL] 
key to select multiple plots, or clicking the Select All button to select all 
of the listed plots. 

4. When all desired plots have been highlighted, click the Print button to 
open the system print tool for plot printing. 

5. Use the system print tool to select and print to the desired printer. 
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Load Completed Plots into Raw Database Tables 
 
After completed plots have been fully edited as described in the section of this 
guide entitled “Edit Completed Plots”, they should be loaded into the database.  
The raw database stores the field data for future reference … the raw database 
tables are intended to preserve the field collected data as it was prior to office 
edits by admin users.   
 

1. Once logged in on the MIDAS website, click on Edit > Plot Editor – 
Field under Menu Options on the left side of the web page. 
 

 

2. On the Plot Editor Field screen, specify a Region, Study Type, and 
Measurement Type … then click the Load Plots into Database button. 
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3. In the Load Plots Into Database screen, select the plots to be loaded into 
the database from the list of Available Plots.  To select all of the listed 
plots, click the >> button.  Otherwise, click to highlight the desired 
plots, using the CTRL key to select multiple plots … then click the > 
button to move the selected plots to the Selected Plots list.  To remove 
any undesired plots from the Selected Plots list, click to highlight the 
plot then click the < button.  The << button will remove all plots from 
the Selected Plots list. 
 

 

4. Click the Load DB button. 

5. A warning message will appear to indicate that the plots will be loaded 
into the Field database tables … click Continue to proceed with the data 
load. 

6. Click OK when a message appears indicating that MIDAS is finished 
loading plots into the database. 

7. Despite the “finished” message, an error message may be presented if 
any problems should occur in loading the data … click the OK button to 
close the error message. 

 

8. A status report will be displayed, listing each plot that was included in 
the list of selected plots to load along with the status of the load for each 
plot. 
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9. If any plots are displayed with Failed highlighted in red, click on the 
specific count included in any of the error columns for that plot to 
determine what caused the failure for that plot. 

a. For example, click on the DbLoadErrors column with a count of 1 
for the failed plot … 

           
 

… to present a listing of the error description: 
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b. Possible errors that may cause a load to fail include the plot having 
been previously loaded or the plot having a “Must Fix Error” … all 
errors must be resolved before the plot can be loaded. 
 

c. Note that if a plot failed because it has already been loaded into 
the database and there truly is a need to replace the previously 
loaded plot, contact a MIDAS Administrator to have the previously 
loaded plot deleted.  This task is available via the MIDAS website 
by selecting Delete Field Plot from Database from Admin Tools 
under the Menu Options on the left side of the screen, however 
Administrative level privileges are required. 

 

10. Use the Close button to close the status report or print a copy of the 
plot list using the screen’s Print button. 

11. Once the plot or plots have been loaded into the database, the 
completed plot(s) will be removed from the list of plots that appear in 
the Midas Work folder on the PDR and on the PC. On the PDR, 
successfully loaded plot files are moved to the 
C_Drive\Midas\Midasdata\Transfer folder. On the PC, successfully 
loaded plot files are moved to the C_ 
Drive\Midas\Midasdata\DBloaded folder. In the event that a plot 
file needs to be manually removed from the Work folder: 

a. On the PDR, open the MIDAS Mobile application or (if already 
open) navigate to the main Plot Task screen. 
 
Note: To navigate to the main Plot Task screen from within an 
open plot file, return to the main menu screen via the [F4] key or 
the Close button on the menu bar at the bottom of any data entry 
screen then click the Exit Plot button. 

b. On the main Plot Task screen, click the Delete Plot button. 
 

 



MIDAS_UsersGuide 2-26-10 ver3.docx  Page 82 of 124 

c. In the Delete Plots screen, use the drop-down boxes on the left 
side of the screen to narrow down the list of plots in the plot list. 

 

 

d. Click to highlight the desired plot for deletion then click the Delete 
button. 

e. When prompted to confirm plot deletion, click the Yes button to 
proceed. 

 

 

f. A message will appear indicating that the plot was successfully 
deleted … click the OK button. 

g. Click the Exit button to close the Delete Plots screen. 
 

Plot Tracking  
 
The MIDAS web site has a plot tracking feature that provides crews with access 
to the list of plots selected for field measurement.  Using this feature, crews 
will be able to retrieve real-time information from the database concerning the 
status of each plot, which plots have been completed and loaded into the 
database.  The plot tracking feature has a number of filters to customize what 
information the user is seeking and how it is presented. 
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1. Once logged in on the MIDAS website, click on Utilities > Field Plot 
Tracking under Menu Options on the left side of the web page. 
 

 

2. On the Field Plot Tracking screen, specify the Study Type and Plot 
Selection details (such as Region, State, etc) as needed to narrow down 
the list of plots … then click the Next button. 

3. Select the desired tracking options … then click the Next button. 
 

 

4. A spreadsheet-like screen will be presented listing all plots that meet the 
specified selection criteria as summarized below the list of plots. 
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5. Use the Print Plot List and/or Save Plot List buttons to print a hard 
copy of the resulting plot list or to save the list to an html formatted file 
… click the Close button when finished. 




